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Release Type and Definition

Integrated Dell Remote Access Controller 7 (iDRAC7)

IDRACY is a systems management hardware and software solution that provides remote management
capabilities, crashed system recovery, and power control functions for Dell PowerEdge systems.

Lifecycle Controller 2 Remote Services (LC2-RS)

LC2-RS provides advanced embedded systems management and is delivered as part of iDRAC7. LC2-RS
enables remote systems management in a one-to-many method. Remote Services uses WS-
Management (WS-MAN) protocol based Web services interface to remotely provision and manage the
servers.

Version
iDRAC7 1.65.65
LC2148

Release Date
December 2014

Previous Version
iDRAC7 1.57.57
LC214.2

Importance

RECOMMENDED: Dell recommends applying this update during your next scheduled update cycle. The
update contains feature enhancements or changes that will help keep your system software current and
compatible with other system modules (firmware, BIOS, drivers and software).

Platform(s) Affected

IDRACY and LC2-RS is supported on the following systems:
e PowerEdge R920

What is Supported?
Supported Managed Server Operating Systems for iDRAC7

The following operating systems support iDRACY:
e Windows Server 2008 SP2 (32-bit)
e Windows Server 2008 SP2 (64-Dbit)
e Windows Server 2008 SP2 R2 (64-bit)
e Microsoft Server 2012 Essentials
e Microsoft Server 2012 R2
e Red Hat Enterprise Linux (RHEL) version 5.9
e Red Hat Enterprise Linux (RHEL) version 6.4
e Red Hat Enterprise Linux (RHEL) version 6.5



e Red Hat Enterprise Virtualization (RHEV) Hypervisor 5.9

e Red Hat Enterprise Virtualization (RHEV) Hypervisor 6.4

e Red Hat Enterprise Virtualization (RHEV) Hypervisor 6.5

e SUSE Linux Enterprise Server (SLES) version 10 SP4 (64-bit)
e SUSE Linux Enterprise Server (SLES) version 11 SP2

e VMware vSphere version 5.0 U2

e VMware vSphere version 5.1 U2

e VMware vSphere version 5.5

e Citrix XenServer version 6.1

e Citrix XenServer version 6.2

Supported Web Browsers for iDRAC7

e Microsoft Internet Explorer 8
e Microsoft Internet Explorer 9
e Microsoft Internet Explorer 10
e Microsoft Internet Explorer 11
e Safariversion 5.2

e Safariversion 6.0

e Mozilla Firefox version 22

e Mozilla Firefox version 23

e Google Chrome version 27

e Google Chrome version 28

What's New

IDRACY defect fixes - See the iDRACY Fixes section for details.

iDRAC7 - Fixes

e {DRAC Web interface reports RACO501: iDRAC Web GUI has no valid information in the Storage
section, that is, no out-of-band capable storage controller detected.

e Insertion of 1600W (excluding Power Supply Unit (PSU)) does not generate a SEL entry to
indicate that the PSU is not configured correctly.

e Redundancy remains degraded after the failed PSU is removed and replaced with a good PSU.

e During boot at end of POST, erroneous 1600W PSU messages are generated from the system if
there is a 1100W PSU and 750W PSU mismatch.

e racadm set iDRAC Security. CsrOrganizationName does not allow you to use racadm sslcsrgen -g
command.

e IDRACY - Getting a configuration from iDRAC7 using racadm getconfig —f command and then
replicating the identical configuration to another iDRACY results in an error for the object
"cfgNetTuningNic100MB=2". This object cannot be set manually if auto-negotiation is enabled.

e PhysicaldiskID value is null after background initialization is completed.
e PERCO9: Inconsistency in listing of Virtual Disks using RACADM.

e PERCO: In real-time, RACADM and iDRAC Web interface does not display the physical disk state
correctly.

e PERCO: Patrol Read state of physical disk is displayed as unknown in RACADM.

e Cannot create virtual disk on external controller when intermal controller is present.



Unable to update the MD1420 external enclosure firmware DUP.
PERCO9: Multiple LCLog export to local share makes the iDRAC unresponsive.

12th generation PERC9: Foreign configuration is imported automatically when auto-import
feature is disabled.

iDRAC7 - Important Notes

After an IDRACY firmware update, a few of the iDRACY Web interface panels or navigation menu
items may contain incorrect or invalid entries. To resolve this, clear the browser cache(s) after
updating the iDRACY firmware.

License Requirements:

—  Software licensing has replaced hardware licensing. For more information, see, the Dell License
Manager User's Guide.

— Lifecycle Controller features such as Auto Discovery and vFlash are now licensed. Install the correct
licenses for Lifecycle Controller Remote Services to work properly.

Only if there is one or more network interface cards (NDC or LOM) present on the managed
system, Network Devices appears under Overview -> Hardware section in the iDRAC7 Web
interface.

When using iDRACY Web interface in Firefox 3.6 if the SD card is removed while partition
creation is in-progress, "The operation has been completed successfully” message is displayed.

For the Virtual Console and Virtual Media to function properly, iDRAC7 Web URL must be added
to the Local Intranet site list and the security level for the Local Intranet zone should be set to
Medium-Low. In addition, if Virtual Console and Virtual Media are configured to use Java plug-in,
then disable the Enhanced Security Mode in Internet Explorer. If this is not possible, then in
IDRACY, configure Virtual Console to use the ActiveX plug-in.

If the instant messenger is launched in the Virtual Console viewer with ActiveX native plug-in
and another application is started (example Notepad, WordPad, and so on) without minimizing
the Virtual Console, the instant messenger box also pops-up on other applications. This does
not happen with Java plug-in.

When a system is in POST, it is not possible to attach a vFlash partition as the first boot device.

Virtual Console Viewer from iDRACY Web interface terminates when the managed system is
restarted.

A pop-up message is not displayed to confirm if test emails are successfully sent or not.

For iDRACY Enterprise, when the Virtual Console is disabled and Virtual Media is disabled and/or
detached, the console port (default: 5900) remains open. For iDRAC7 Express (no Virtual Console
or Virtual Media) the console port is open.

If auto-negotiation is enabled while setting iDRACY network, 1 Gbps is not supported and you
cannot manually select it.

A USB device mounted through Virtual Media in floppy emulation mode for a Linux operating
system shows as a removable volume.

During system power operations, if the video mode changes, the message "Out of range” may
appear for a short while on the Virtual Console.

When using the Virtual Console in native console mode with "Pass all keystrokes to server”
disabled in Internet Explorer versions 8 and 9, if an F1/F2 prompt is encountered, pressing F1
displays the Virtual Console online help pop-up in addition to continuing with the system boot.

When any of the storage enclosure components are removed, the corresponding details are not
displayed. Only the name and status attributes are displayed.

When certain RAID operations are requested using WS-MAN on non-RAID cards such as, the
Dell SAS 6Gbs HBA or the Internal Tape Adapter, the operation succeeds, however the job fails
with the error message "Unable to locate device in current configuration”.

If the IDRACY network is configured to use a shared LOM and the spanning tree is enabled on
the LOM port, WS-MAN and remote service commands may time-out in the following scenarios:

— At system reboot



— When CSIOR is running
— While entering SSM
The connectivity lost is variable. In typical cases, it is approximately:

— 40 seconds at system reboot and varies per NIC or link speed
— 20 seconds when CSIOR is running
— 40-60 seconds while entering SSM

The reason is that when spanning tree is enabled, the switch does not allow the link to re-establish the
connection after a reset until it completes checking for network loops. Server reboots reset the NIC and
disconnects the link.

Note: This does not occur while using dedicated NIC because server reboots do not affect the dedicated
NIC.

When logging in to iDRACY Web Interface using Intermet Explorer 9 and IPV6 address, the
connection may not succeed. To resolve this, make sure that in Internet Explorer -> Tools ->
Internet Options -> Connections -> LAN Settings, the Use automatic configuration script
option is cleared.

On PowerEdge systems with cabled power supply units installed (that is, PSUs which do not
provide PMBus support), power values may still be displayed in the iDRAC7 web and LCD
interfaces. Due to lack of PMBus support in the PSUs, the power values displayed on the GUI
pages, including the Overview -> Hardware -> Front Panel page, are not correct.

Due to the independent nature of the alert processes (e-mail, SMTP, remote syslog), when
changing the licenses that affect alert features (example, email alerts for Express or remote
syslog for Enterprise) there is no guarantee of the timing of the features being activated or
deactivated when the license changes.

In the iIDRAC Web interface, when the System Inventory page is accessed for the first time, it
takes up to two minutes for the inventory data to be collected. After the data collection is
complete, refresh the page to display the inventory data.

Make sure to synchronize the iDRAC time with the management station's time to avoid
certificate related issues. If the time is not synchronized, issues such as server certificate
expiration may be seen. If this occurs, re-synchronize iDRAC time with the management
station'’s time and reboot iDRAC.

On a Linux system, after launching the Virtual Console, if you click on a menu item and it
remains open, the Ctrl + Alt + L keystroke sent from the iDRAC to the host system does not lock
the host system. The behavior is the same as using a local keyboard.

The default time zone value is US Central Time. To make sure Single Sign-On (SSO) and
Directory Service TFA (smart card) continue to work properly, the iDRAC time zone must match
the time zone where iDRAC is located, assuming Active Directory server's time zone is already
configured to match the Active Directory’s location. For example, if Active Directory server is
located at US Eastern time zone and iDRAC is located at US Pacific time zone, Active Directory
server has to be configured as US Eastern time zone (this is Active Directory server configuration
and is normally configured), and iDRAC must be configured as US Pacific time zone.

For more information to configure the time zone, see the iIDRACY User's Guide.

If the management station is using MAC operating system, it takes more time to launch the
Virtual Console due to the following DNS search issue:
http://www.eigenspace.org/2011/07/fixing-osx-lion-dns-search-domains/

For iDRACY 1.30.30 or later versions, if the iDRAC is configured using the Import Configuration
XML operation, "user password is changed” messages are logged in the Lifecycle Log. An LC Log
entry is generated and the default settings are applied for all local user accounts that are not
configured through the XML configuration file.

The help page for the Export and Import of Server Profile feature does not provide the correct
share name. See the Web Services Interface Guide available at www.dell. com/support/manuals
for the correct share name.

Remote Sys Log settings take effect only if you do the following:
— Enable remote syslog feature
— Specify the server address and port number

— Enable Remote SysLog option on the Alerts page



e  When IVYBRIDGE CPU is installed on PowerEdge R720, R720xD, R620, T620, or M620 systems,
the iDRACY firmware update from 1.45.45 to an earlier version is not allowed (example, from
1.45.45 to 1.40.40 or to 1.37.35, and so on).

e When creating a Virtual Media image from a folder, the output image file size is at least 512 MB.

e Tolaunch Virtual Console using Java plug-in, only JavaWebStart versions 1.5, 1.6, and 1.7 from
Sun (Oracle) is supported. Any other versions or any other installations are not supported.

e On a server running RHEL operating system, performing the following steps can create a
eth*.bak interface (where * is the interface number). This is visible in the Network Manger
interface. This interface can be safely ignored.

1. After the operating system (RHEL) is running, enable OS to iDRAC Pass-through channel
through the iDRAC Web interface.

2. Disable OS to iDRAC Pass-through.
3. Reboot or power cycle the server, and then re-enable OS to iDRAC Pass-through.

e When upgrading the iDRAC firmware from any version earlier to 1.30.30 to 1.30.30 and later, the
Alert destination addresses resets to zeros. The same is applicable when downgrading from
version 1.30.30 or later to any previous version. In such a case, reconfigure the Alert Destination
[P addresses (Server->Alerts->SNMP and Email Settings).

e Any change in VNC server settings disconnects the active VNC session.

e USB NIC is supported on RHEL 6.5 32-bit and RHEL 6.5 64-bit operating systems. On any Linux
operating system, for https://idrac.local to work, the avahi, nss-mdns, and dependent packages
must be installed.

iDRAC7 - Known Issues

Issue 1

Description

In Chinese locale on Windows operating system, while launching the Virtual Console using Java plug-in,
occasionally you may see a Java compilation error.

Resolution

1. Open the Java control panel.

2. Go to General -> Network Settings.

3. Select Direct Connection and click OK.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 2:

Description
Known iIDRACY IPv6 limitations:
o0 Email alerts are not sent if the iDRAC7 DNS Domain Name is not specified when using IPv6.

o0 Network File Share (NFS) mounting does not work with IPv6. This applies to features such as
connecting a remote file share or exporting the Lifecycle Controller log to a network shared
location.

o Firefox versions 4.x, 6.x, and 7.x may prevent the iDRAC7 Web interface from opening when
using IPv6. For more information see: https://bugzilla.mozilla.org/show_bug.cgi?id=633001

o0 On Microsoft Windows Operating Systems, when launching Virtual Console using Java plug-in
or when launching Video Capture plug-in, empty warning dialogs may appear. Continue to click
OK to launch the plug-in. This is a known limitation in Java Web Start if its Network Settings is
set to use browser settings. To resolve this, set the Java's Network Settings to Direct Connection.

Resolution (only for logging in to iDRAC7 Web interface):

1. Register iDRACY to DNS.
2. Make sure the client system also has this DNS in its DNS list.



3. Enable [Pv6 and disable [Pv4.
4. Log in to iDRACY using the Fully Qualified Domain Name (FQDN).

For launching Virtual Console with IPv6 in Firefox 4.0 or later versions, from Windows management
system, run ipconfig /flushdns in the command prompt.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 3:

Description
The Learn More pop-up on the License page does not appear using IE.
Resolution

Add *.dell.com to the trusted sites in the Security settings. See the /nternet Explorer help documentation
for more information.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 4:

Description

On Windows operating system, to add a folder as an image using the Virtual Media, the Desktop
directory must be in the HOMEPATH directory. The HOMEPATH directory may vary depending on the
Windows installation, but the images created from the "Add Folder as Image” operation always reside in
the %HOMEDR IVE%\%HOMEPATH%\Desktop directory. The HOMEDRIVE must be set to C drive. Otherwise,
the operation fails.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.

Issue 5:

Description

If the management station is using Linux operating system with the Pass all keystrokes to server option
enabled, you cannot resize the Virtual Console viewer window by dragging the corners or frame. This is
a limitation of X-Windows.

Resolution:
Do any of the following:
o Disable the Pass all keystrokes to server option.

o With Pass all keystrokes to server option enabled, open any menu in the Virtual Console viewer
window title bar, and then re-size the window.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 6:

Description
vFlash functionality remains enabled after firmware update without preserving configuration.

If vFlash functionality is enabled and a firmware update is performed without preserving the
configuration (Preserve Configuration is not selected), the vFlash Enabled option remains selected.
This is a known behavior.



Resolution

You must manually enable or disable the vFlash functionality after the firmware update as required. To
do this, select or clear the vFlash Enabled option in the iDRAC7 Web interface, or use RACADM or
WinRM remote service commands.

Versions/Systems Affected
All1DRACY supported Dell PowerEdge systems.

Issue 7:

Description

In some scenarios, typically for state change events occurring within a span of few seconds, the
sequence of events reported in the Lifecycle Log (or corresponding SNMP traps/email alerts) for storage
devices may not exactly match the sequence in which they occurred.

Resolution

The current state or attribute of the storage device can be checked in any of the iDRACY interfaces
(example, iIDRAC7 Web interface, RACADM and so on).

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY and out-of-band enabled PERC storage controllers.

Issue 8:

Description

When enclosures connected in the redundant path are re-wired (connections are switched) to result in a
non-redundant path, the reported connected port value of the enclosures may not be accurate.

Resolution

Power cycle the server.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 9:

Description

When a storage enclosure is disconnected or accidentally removed, the corresponding status of its
components (that is, EMM, PSU, fan, and temperature sensors) is reported as critical.

Resolution

If the storage enclosure is disconnected accidentally, reconnect it to get back to normal state. If it is
intentional, perform iDRACY reboot or server power cycle to remove the enclosure entries from the
consoles.

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 10:

Description

Logging in to iDRACY Web interface fails with the error message 'RAC0218: The maximum number of
user sessions is reached’.

When the temporary folder used by iDRACY components is full, it is possible that authentication fails and
this error is displayed.

Resolution

Power cycle iIDRACY to clear the temporary space.



Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 11:

Description

On Microsoft Windows? operating system, while launching Virtual Console in native mode using
Internet Explorer, the iDRAC7 Login page is displayed.

Virtual Console uses plug-ins and due to insufficient privileges plug-in does not load and iDRAC7 Login
page is displayed.

Resolution

Reboot operating system and log in to iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 12:

Description

When selecting browser buttons (forward or back), the GUI pages are not displayed correctly and
sometimes the same page re-appears.

IDRACY Web interface is a platform management application and all the necessary controls are provided
within the application. The Web browser buttons are outside of this application and may not function

properly.

Resolution

Use the navigation options within the iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 13:

Description

When you log in to iDRAC7 Web interface using Internet Explorer 9.x, contents in few pages are not
shown properly. This is a known issue with Internet Explorer.

Resolution

1. Press <F12>. The Internet Explorer 9 Debug window is displayed.

2. Select Document Mode -> Internet Explorer 7. The browser refreshes and the iDRAC7 Login page is
displayed.

3. Close the Internet Explorer 9 Debug window.

4. Close all open Internet Explorer windows.

5. Open Intemet Explorer and log in to iDRACY.

For more information, see Internet Explorer documentation.
Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 14:

Description
When an Enterprise or Enterprise Evaluation license expires, Active Directory is disabled automatically.
Resolution

After re-installing the Enterprise or Enterprise Evaluation license, an administrative user can log in as an
existing local iDRACY user to re-enable Active Directory authentication, using any iDRACY interface such



as RACADM or the Web interface. Remote RACADM can be used in a script to batch-enable Active
Directory. If a local iIDRACY user is not enabled or is not configured for remote access, the administrative
user must use local RACADM or OpenManage Server Administrator to configure a local user.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 15:

Description

When a power reset is performed, the Virtual Console Viewer menu options (except File -> Exit and
Help options) are grayed-out or inaccessible. The 'Link interrupted’ message appears at the bottom of
Virtual Console Viewer.

Resolution

Due to a temporary network outage, the Virtual Console Viewer menu options are not accessible. The
"Link interrupted” message is displayed to indicate that an outage has occurred. This is a temporary
problem and the menu options are available when the network is restored.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 16:

Description

IDRACY Web interface does not respond when using Intemet Explorer.

Resolution

Close all Internet Explorer sessions and open it again to access iDRAC7 Web interface.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 17:

Description

When a driver pack DUP update is performed, the following message is recorded in the Lifecycle log after
the driver pack update entry.

RAC0400: iDRAC memory low 1IDRAC is running low on memory. System performance may be degraded.
Recommended Action: No response action is required.
Resolution

No workaround is required. This is a normal condition when the memory is lower than the threshold for
around 30 seconds and returns to normal after the driver pack update finishes.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 18:

Description

Resetting iDRACY to default values action may take between four to six minutes to complete.
Resolution:

Wait for iDRACY to reboot before performing any other action.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 19:

Description

In the iDRACY Web interface -> Overview -> Server -> Power/Thermal -> Power Monitoring tab ->
Power section, the Power Unit selector only changes the unit of measure. Due to the oscillating nature
of power, the Present Reading cannot be displayed as units for Current (Amps).

Resolution

None.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 20:

Description

On all Intel NICs, each port cannot be assigned different iSCSI initiator name (by assigning the value for
[scsilnitiatorName). If the name is changed for one port, the same change is applied to all ports.

Resolution

None.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 21:

Description

When virtual world wide name and virtual world wide port name attributes on a NIC partition are set
using the WS-MAN interface, the new values are not updated in the iDRAC7 Web interface or when
racadm getsysinfo is run

Resolution

Use WS-MAN interface to obtain the updated values for those attributes.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 22:

Description

The Predicted Capacity Status attribute of the storage controller battery reported by IDRACY interfaces
may not be accurate in some situations.

Resolution

The Predicted Capacity Status attribute has been deprecated. To view the correct battery state, use the
storage battery state/status values instead.

Versions/Systems Affected
All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 23:

Description

When inventory changes are done to the storage sub-system (such as inserting and removing disk drives,
and so on) before or during POST/reboot, the corresponding events may not be recorded in Lifecycle log.
SNMP traps/email alerts may not be generated and the inventory changes may not be correctly reflected
in the iDRACY interfaces (example, iDRAC7 Web interface, RACADM and so on).



Resolution

To view the correct storage inventory data, perform a server power cycle (cold boot).
Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PERC storage controllers.

Issue 24:

Description

If a NIC card, with partitioning enabled, is replaced with a similar type of card, without partitioning
enabled, the configurations from the previous card are not applied to the new card.

Resolution:

After the previous card is replaced with a new card and the system is powered on, go to OptionROM
(CTRL-R) and enable partitioning. Save, exit, and reboot the system.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 25:

Description

When using DownloadServerPublicKey or DownloadClientCerts commands in WSMAN, the invocation
may fail when the iDRACY system is not ready to service the operations. This may happen when host
system is in a POST stage.

Resolution

Wait until host system is past the POST stage and retry the command.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 26:

Description

When launching Virtual Console viewer using ActiveX plug-in, a blank window appears and Virtual
Console viewer does not launch.

Resolution

This may be due to incompatible binaries from a previous version. Remove temporary files from the
download location on your system (for example, C:\windows\Downloaded Program Files) and retry.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 27:

Description

When video player is launched, it launches both a playback control window and a playback window. On
a Linux RHEL6.0 workstation, if the playback window loses focus, then you cannot switch back using the
mouse.

Resolution:

This is an issue with the RHEL 6.0 version of Linux. Close the playback control window by selecting X'
and select the playback program on task bar using the mouse to display the playback window. If you
need to view the playback controls again, select its menu item from the playback window.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.



Issue 28:

Description:

When running the Virtual Media client on Windows 7 or Windows Server 2008 R2, the Virtual Media
client may not be able to access a floppy disk in read-write mode because of a problem with the client
workstation operating system.

Resolution:

Apply the operating system update to the Windows 7 or Windows Server 2008 R2 client workstation
operating system as specified in the following link: http://support.microsoft.com/kb/2496290.

Versions/Systems Affected

All iDRACY supported Dell PowerEdge systems being accessed by a Windows 7 or Windows Server 2008
R2 client workstation without the specified update applied.

Issue 29:

Description:

There is no option to eject the USB drive on SUSE Linux Enterprise Server 11. The only option to unmap
virtual USB is to force unmapping using the Virtual Media window.

Resolution:

Unmount virtual USB before forced unmapping to make sure the server has completed all the pending
tasks before the drive is unmapped.

Versions/Systems Affected
AILIDRACY supported Dell PowerEdge systems.

Issue 30:

Description:

In a Linux operating system, after logging in to the iDRAC Web interface using a Firefox browser and you
launch the Virtual Console, sometimes Virtual Console window does not respond to keyboard input.

Resolution:

Close and re-launch the Virtual Console.
Versions/Systems Affected

AILIDRACY supported Dell PowerEdge systems.

Issue 31:

Description

When there is no license installed on a value line platform like T420, you cannot perform any firmware
update through iDRAC Web interface using Dell Update Packages (DUPs). This is the correct behavior,
but the displayed error message is not correct. Error message is "LIC006: The License has expired. Obtain
a replacement license and import it.”

Resolution

Obtain an appropriate license then try again. If the problem persists, contact the technical support. See
the product documentation to choose the contact method that is convenient for you.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 32:

Description

[f you try to upload any other certificate other than a valid PKCS#12 format file, the iIDRAC Web interface
displays an incorrect error message.



Resolution

Upload a valid PKCS#12 format certificate file.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 33:

Description:

On applying Delete Custom SSL Certificate when no certificate (CSC) is available, GUI displays the
message: RAC0507 Unable to find the requested resource. Do one of the following and retry the
operation:

0 Turn on the system.
o0 Make the resource available.
Resolution:
No impact as such, the request to delete non-existent CSC results in this message.
Versions/Systems Affected.:
All Dell PowerEdge systems with iDRACY.

Issue 34:

Description:

After uploading a custom signing certificate to iDRAC and restarting iDRAC, when you log in to iDRAC
Web interface using Firefox browser, the security certificate error is displayed. This is because the serial
number of the certificate that was stored in the Firefox browser cache is the same as the serial number
of the certificate on iDRAC.

Resolution:

Remove the browser certificate in the cache and log in to the iDRAC Web interface. For information on
removing certificates, see the Firefox documentation. If the problem persists:

1. Log in to iDRAC using racadm and run sslresetcfg.
2. Perform steps to upload custom signing certificate.

Issue 35:

Description

On PowerEdge M520, if a Broadcom 57810S DP 10G KR Mezz 55 GHP or Qlogic DP 10 Gb SFP+/DA CNA
Mezz RX8GJ is installed, an additional blank entry is displayed in the System Inventory page of the Web
interface and on other interfaces such as RACADM, WSMAN, and Lifecycle Controller GUL

Resolution

This is a false entry and can be ignored.
Versions/Systems Affected

Dell PowerkEdge M520

Issue 36:

Description

Sometimes invalid characters are displayed on the server console screen after exiting iDRAC Virtual
Console.

Resolution

Launch virtual console and clear the Automatic System Lock option.
Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.



Issue 37:

After an iIDRACY firmware update, some of the iDRACY Web interface panels or navigation menu items
may contain incorrect or invalid entries.

Resolution

Clear your browser cache(s) after updating the iDRACY firmware.

Versions/Systems Affected

All Dell PowerEdge systems with iDRACY.

Issue 38:

Description

Credential vault contents may be erased when upgrading to or downgrading from iIDRACY firmware
version 1.40.40, resulting in different symptoms.

Resolution

Back up the Credential Vault data (uploaded certificates, and so on) before upgrading to or downgrading
from IDRAC7 1.40.40 firmware. After the firmware update is complete, reload the Credential Vault
contents.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 39:

Description

In the IDRAC7 Web interface > System Inventory page, the AMULET Video Mezzanine card description is
displayed as "Whistler[Radeon E6760]" and the description for Manufacturer is displayed as "Advanced
Micro Devices[AMD]nee ATT".

Resolution

No impact and can be ignored.

Versions/Systems Affected

PowerEdge M420, PowerEdge M520, and PowerEdge M620 systems with iDRACY.

Issue 40:

Description

When the host operating system is Windows Server 2012 Re, if the Virtual Media device is mapped to the
host system and if you try to perform firmware update to an earlier version using Dell Update Package
(DUP), the firmware update process may stop.

Resolution

[f you want to update the firmware to an earlier version (example, from 1.45.45 to 1.40.40 or to 1.37.35,
and so on), use the iIDRAC7Y Web interface instead of a DUP package. If you have to use a DUP, then
before running the DUP, make sure there are no active Virtual Media sessions on iDRAC.

Versions/Systems Affected:
All 12th generation Dell PowerEdge servers with Windows Server 2012 R2 operating system.

Issue 41:

Description

When performing firmware update using local racadm with —pud option (update from the host server), if
racadm is not invoked from the installation directory (example, C:\Program Files\Dell\Sysmgt\iDRAC)\),
then after the firmware update is completed successfully, the following error message may be displayed:

"Waiting iDRAC Fully Initialized Timeout”



Resolution
Run local racadm from the racadm installation directory.

Issue 42:

Description

[n the IDRAC7 Web interface, the System Inventory or Network Device page for Fibre Channel devices
does not display the current firmware version or vendor name details for Emulex FC16 card.

Resolution

Update the FC16 firmware twice from the operating system (not using the iDRAC update method). For
more information, see Emulex documentation.

Versions/Systems Affected
All Dell PowerEdge systems with iDRACY.

Issue 43:

Description

In systems with iDRAC 1.30.30 firmware version, the sslencryptionstrength racadm command does
not work for both firmware and local racadm interfaces.

Resolution

Use the remote racadm interface, IDRAC Web interface, or WSMAN to configure the SSL encryption
length. You can also use idrac.webserver.LowerEncryptionBitLength object.

Versions/Systems Affected
All 12th generation Dell PowerEdge servers with iIDRACY version 1.30.30.

Issue 44:

Description

After exiting virtual console from iIDRAC sometimes invalid characters appear on the server screen when
1s there is no desktop running on the server operating system.

Resolution

Launch Virtual Console and clear the Automatic System Lock option.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 45:

Description

Full export of Lifecycle Controller logs in Mac OS through Safari browser generates Log.xml file instead
of Log.xml.gz file and the Log.xml contains partial content.

Resolution

1. Open Safari in Mac.
2. Go to Safari > Preferences > General.
3. Clear the Open 'safe’ files after downloading option.

Versions/Systems Affected
All iDRACY supported Dell PowerEdge systems.



Issue 46:

Description

In some scenarios, typically when a PCle SSD is removed from a server slot and a different PCle SSD is
inserted within a span of 5-10 seconds into the same slot, the server fan speeds may not get optimally
configured to accommodate the thermal profile or tier of the inserted PCle SSD.

Resolution

Power cycle the server.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and PCle SSDs.

Issue 47:

Description

On servers with Windows 2008 SP2 64-bit operating system, the iDRAC Virtual NIC USB Device is not
discovered automatically (or enabled). The iDRAC Virtual NIC USB Device appears under unknown
devices with yellow bang (or warning symbol).

Resolution

See steps recommended by Microsoft to manually update the RNDIS driver for this device.
Versions/Systems Affected

All Dell PowerEdge Systems with iDRAC7.

Issue 48:

Description

If the system with Linux operating system is stand alone or connected to a network hub, the
communication to iDRAC through the OS to iIDRAC pass-through channel for LOM pass-through mode
does not work in the following scenarios:

1. For systems shipped from factory, initially the iDRAC network is in dedicated mode and the OS to iDRAC
pass-through feature for LOM pass-through mode is disabled. The network cable is installed at LAN1. The
host and the iDRAC IPs are configured for static IP addresses in the same subnet. Switch the iDRAC
network from dedicated to shared mode, enable OS to iDRAC pass-through and set the pass-through
mode to LOM.

2. When LANL1 is connected to a switch:

a. Both IDRAC and the host IPs are configured for static IP addresses in the same subnet.

b. Either iDRAC or the host IP is configured for static IP address and the other one
received the IP through DHCP.

c. 1DRAC and host both receive the IP through DHCP.
Resolution

To enable OS to iIDRAC pass-through in shared mode:

1. Set the static IP address on the host system using the Network Manger GUI or edit the
/etc/sysconfig/network-scripts/ifcfg-etho file.

2. Set the static [P address for the iDRAC in the same subnet

3. Enable OS to IDRAC pass-through feature. For the steps, see iIDRACY User's Guide at
www.dell.com/esmmanuals.

4. Reboot the host system.

5. After restarting the host system, connect to the iDRAC using the static iDRAC IP address.

Versions/Systems Affected
All Dell PowerEdge Systems with iDRACY.



Issue 49:

Description
When logging into iDRAC console, occasionally log in fails with PKCS security error.
Resolution

Run the racadm sslresetcfg command to clear this issue and log in successfully. This installs the
default certificates and any self-signed or customer SSL certificates are replaced with the default
certificate.

Versions/Systems Affected
All Dell PowerEdge Systems with iDRACY.

Issue 50:

Description

[N IDRACY version 1.45.45, if the OS to iIDRAC Pass-through mode is set as LOM-PT and if you update the
firmware to iDRAC7 1.51.50 with preserve configuration, the pass-through mode value resets to USB-NIC
instead of LOM PT.

Resolution

Re-configure the OS to iDRAC pass-through mode to LOM-PT using RACADM or iDRACY Web interface.
Versions/Systems Affected

All 12th generation Dell PowerEdge Systems with iDRACY 1.50.50 or later.

Issue 51:

Description

On a few servers, the remote get operation (type INI) is unsuccessful for the thermalsettings group.
However, on the basis of the thermalsettings table of for 12th generation servers, this issue may or may
not arise.

Resolution

Perform an individual group query or perform an XML file operation. For details about the group,
individual group query can be performed.

Versions/Systems Affected
All 12th generation Dell PowerEdge Systems with iDRAC7 1.51.50.

Issue 52:

Description

If the Virtual Console is launched with IPv6 address and ActiveX in shared mode on NDC card (JC10M -
Broadcom 57840S Quad Port 10Gb SFP+) and system is rebooted, Virtual Console disconnects and does
not automatically reconnect.

Resolution

Re-launch the Virtual Console.

Versions/Systems Affected

All 12th generation Dell PowerEdge Systems with iDRAC7 1.50.50 or later.

Issue 53:

Description

On servers with RHEL 5.x operating system, after upgrading to Java 1.7.0, attempting to launch the Java
Virtual Media, Virtual Console, or Boot Capture plug-in results in an “Unable to load Native Library”
message, and the Virtual Media is disabled. This issue is caused by the Security Enhanced Linux (SELINUX)
“allow_execmod” policy being set to “off’, preventing the Virtual Media operation.



Resolution:

Set the allow_execmod policy to ‘'on’ by running the following command:
setsebool -P allow_execmod on

Versions/Systems Affected

All versions of iDRAC on 12th generation Dell PowerEdge Servers.

Issue 54:

Description

After upgrading to Java 1.7.0, a login failure is observed when launching Virtual Media or Virtual Console
using the Java plugins. By default, Java 1.7.0 enables a certificate revocation check for all certificates in
the chain of trust, using both Certificate Revocation Lists (CRL) with the Online Certificate Status Protocol
(OCSP). With these settings, if the network on which the client system resides provides DNS resolution of
the CRL and OCSP server names, but does not provide access to the servers, the temporary
authentication credentials for the Virtual Media or Virtual Console session may expire before the
certificate check times out.

Resolution:

Perform any of the following actions:
e Provide network access to the CRL and OCSP servers.
e Disable DNS name resolution for the CRL and OCSP servers.
e Change the Java Control Panel settings:

0 Perform certificate revocation checks on from All certificates in the chain of trust to
Publisher’s certificate only

0 Check for certificate revocation using from Both CRLs and OCSP to Certificate
Revocation Lists (CRLs)

e Change the Java Control Panel settings Perform certificate revocation checks on from All
certificates in the chain of trust to Do not check (not recommended).

Alternately, restoring the previous Java version also prevents the display of the message. See the Oracle
Java documentation for information on how to uninstall Java.

After uninstalling, re-install Java 7 update 21 (or your preferred version).
Versions/Systems Affected
All versions of iDRAC on 12th generation Dell PowerEdge Servers.

Issue 55:

Description

IDRAC Link local [Pv6 address changes from bondO local link address to USBO local link address as soon
as the OS to IDRAC pass-through is enabled in USB mode.

Resolution
Save bondO interface’s link local IPv6 address before enabling the USB mode for later usage.
Versions/Systems Affected

Platform independent.

Issue 56:

Description

In the case where an NDC supports OS to iDRAC Pass-through feature, but software arbitration is
enabled for NC-SI, the LOM option must be hidden in the iDRAC configuration for OS to iDRAC Pass-
through.



Resolution
Use OS to iDRAC Pass-through channel in USB NIC mode.
Versions/Systems Affected.:

Full Height PowerEdge M820 server with Emulex bNDC ((which supports OS to iDRAC Pass-through but
does not support hardware arbitration).

Issue 57:

Description:

If you have configured the OS to IDRAC Pass-through channel to LOM PT mode and if the iDRAC
firmware is upgraded from 1.45.45 or lower versions to 1.50.50 or above versions, then after the firmware
upgrade, the OS to iDRAC pass-through channel setting changes to USB NIC mode (default setting).

Resolution:
After the firmware upgrade, set the OS to iIDRAC Pass-through mode as LOM PT.
Versions/Systems Affected.:

Platform independent.

Issue 58:

Description:

FCoEWWN and PermFCoEMACAddress are shown as all zeros in Emulex rNDCs and NICs when FCoE
partition is enabled.

Resolution:
Use one of the following work arounds to get the correct values:

e Runracadm get NIC.VndrConfigGroup

e In the IDRAC Settings Utility, use the NIC configuration page to view the FCoE WWN.
Versions/Systems Affected

All 12" generation Dell PowerEdge systems with Emulex tNDCs or NICs with FCoOE partition enabled with
iIDRAC7 1.55.55 firmware.

Issue 59:

Description

When a MD1200/MD1220 storage enclosure’s Enclosure management module (EMM) is removed, its
temperature sensor values are shown in the iDRAC Web interface. iDRAC shows the negative readings
instead of showing them as inactive. The state of the EMM is shown as removed or failed, Only the
values are not shown intuitively to reflect its removed or failed status.

Resolution

Check the EMM's status to make sure the temperature sensor's readings are correct.
Versions/Systems Affected

All 12th generation PowerEdge systems with iDRAC7 and MD1200/MD1220 connected to it.

Issue 60:

Description

For servers with higher configuration (more enclosures and RAID components), firmware Racadm may
not provide the complete output for hwinventory command.

Resolution

Try using hwinventory export command.

Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iIDRAC7 1.50.50 or later.



Issue 61:

Description

If Attach Mode is set to Detach on iDRAC Web interface (on the Attached Media page), then Map
CD/DVD and Map Remove Disk does not appear in the Virtual Media drop-down menu after Virtual
Media is connected from Virtual Console.

Resolution

No impact and can be ignored.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 62:

Description

While executing a remote diagnostics fromm RACADM CLl, the diagnostic mode type of “2-Both” reports
as an invalid input.

Resolution

Diagnostics Mode type 2 is to execute both Express and Extended mode of the diagnostics operation.
This can be achieved by executing Mode 1 and Mode 2 individually for getting the required diagnostics
result.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 63:

Description

According to NIST, key lengths providing less than 112 bits of security strength must not be used to
generate digital signatures after December 31, 2013. The self-signed SSL certificate provided with iDRACY
1.55.55 is signed with a key length of 1024 bits which provides 80 bits of security strength. The next
release will provide a key length of 2048 to follow NIST recommmendations.

Resolution

Option 1:

Provide in-house signed certificate using a key length of 2048 or greater and upload to iDRACY.
Option 2:

Purchase third party signed certificate using a key length of 2048 or greater and upload to iDRAC7.
Versions/Systems Affected

AlLIDRACY supported Dell PowerEdge systems.

Issue 64:

Description

When OS to iDRAC pass-through feature is disabled or if it is set to LOM PT mode and if iDRAC Service
Module is installed on the host operating system, an incorrect warning message is displayed.

Resolution

Make sure that OS to iDRAC pass-through feature is enabled through the internal USB bus in iDRACY.
Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iDRACY.



Issue 65:

Description

On the Firmware Update page, after uploading a .img file, any subsequent request may be redirected to
the Login page. This may be due to a session timeout.

Resolution

Make sure that the session time out is set to a value that is required for the upload process to complete
(at least 2-3 minutes), depending on the file size.

Versions/Systems Affected
All 12th generation Dell PowerEdge systems with iDRAC7 1.55.55

Issue 66:

Description

Under RACADM getsensorinfo command output, the ROMB battery reading is displayed as Unknown
and status is displayed as OK when the battery is not present.

Resolution

In the iDRAC Web interface, see the sensor page or interpret the unknown reading as battery absent.
Versions/Systems Affected

All 12th generation PowerEdge systems with iDRACY.

Issue 67:

Description

With the certificate validation option enabled for Active Directory or Generic LDAP, replacing the
directory service CA certificate does not take effect without resetting the iDRAC.

Resolution

If the certificate validation option is enabled for Active Directory or Generic LDAP, after replacing the
directory service CA certificate, an iDRAC reset is required before attempting to log in with directory
service user or running the login test setting on the iDRAC Web interface test setting page. If it is not
possible to reset the iDRAC at this time, disable the Web server (in the Network > Services > WebServer
section, clear the Enabled option and click Apply). Wait for two minutes and then re-enable the Web
server.

Versions/Systems Affected
AlLIDRACY supported Dell PowerEdge systems.

Issue 68:

Description:

Incorrect version information is provided in the Java Virtual Console About dialog box in Chinese,
Japanese and Spanish localized languages.

Resolution:

No impact.

Versions/Systems Affected

AILIDRACY supported Dell PowerEdge systems.

Issue 69:

Description

If the Rollback page is opened using Mac or Safari browser and if you click Refresh, the RAC0505 error
message is displayed.



Resolution

If the Rollback page is opened using Mac or Safari browser and if you click Refresh, the RACO505 error
message is displayed.

Versions/Systems Affected:
All 12th generation Dell PowerEdge systems with iDRACY.

Issue 70:

Description

After deleting the IDRAC Enterprise license and if you log in to the iDRAC Web interface and navigate to
the Network page, a pop up message ‘Invalid VLAN iD" appears.

Resolution
1. Go to the iDRAC Settings Utility and reset iDRAC to default settings.
2. Login to the iDRAC Web interface and do the following:
a. Navigate to iDRAC Settings > Network > VLAN Settings.
Select the Enable VLAN ID option.
Modify VLAN ID to 1.
Click Apply.
Clear the Enable VLAN ID option.
f.  Click Apply.
Versions/Systems Affected
All 12th generation Dell PowerEdge systems with iDRAC7.
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Issue 71:

Description

On the Network Devices Summary page, if you click Help, the content related to Network Devices
page appears.

Resolution

In Help, search for Network Device Summary to view the correct content.
Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iDRACY.

Issue 72:

Description

The state of the PCle SSD connected to the server is not reflected correctly or takes several minutes to
reflect the correct state.

Resolution

Power cycle the server or re-insert the PCle SSD reflecting the incorrect state.

Versions/Systems Affected

All Dell PowerEdge systems with iDRAC7 and out-of-band enabled PCle SSDs (that is, NNMe devices).

Issue 73:

Description

If the system is powered on and if the server chassis lid is open for any reason, the following System
Event Log (SEL) message may be generated:

SEC0033: "The chassis is open while the power is off.”



Resolution

If the system is still powered on, ignore this message.
Versions/Systems Affected

All 12th generation Dell PowerEdge Rack and Tower servers.

Issue 74:

Description

If the iDRAC has a large number of records in the Lifecycle Log and from remote RACADM, if you run the
racadm Iclog view, an error message is displayed.

Resolution

To view the logs, use local racadm, firmware racadm, iDRAC Web interface or WSMAN. To view the latest
logs using remote racadm, use the -n option. For example, to view the 10 latest logs, use racadm Iclog
view -n 10.

Versions/Systems Affected
All 12th generation Dell PowerEdge systems with iDRAC7.

Issue 75:

Description:

If the license level is Base Management with IPMI, when you upload a Dell Update Package (DUP) in .exe
format, a license related error message appears.

Resolution

[n Base Management with [PMI license, you can only upload .d7 image format. To upload .exe files,
upgrade the license to IDRAC Enterprise and then retry the operation.

Versions/Systems Affected
All 12th generation Dell PowerEdge systems with iDRAC7.

Issue 76:

Description

In the iDRAC Web interface, there is a mismatch in the hardware inventory and the software inventory
for the display name of the Physical disk entries.

Resolution

The software inventory Physical disk display name is not included the Controller Identifier. See the
hardware inventory physical disk display name for information about the Controller Identifier.

Versions/Systems Affected
All 12th generation Dell PowerEdge systems with iDRACY.

Issue 77:

Description

Automatic restore feature is not available in this release and so setting the new value to the Lifecycle
Controller attribute “Automatic Restore Feature” displays the error “Invalid AttributeName”

Resolution

Ignore the Lifecycle Controller attribute "Automatic Restore Feature” during the WSMAN enumeration.
Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iDRACY.



Issue 78:

Description

When accessing the iDRAC Help from FM120x4 server, the Help pages for Backup and Export Server
Profile and Import Server Profile shows content for vFlash option.

Resolution

The vFlash option is not applicable for FM120x4.
Versions/Systems Affected

Dell PowerEdge FM120x4.

Issue 79:

Description

Help page entry for Node ID is not present under System Details page.

Resolution

Node ID is displayed only for FM120x4 server in the <servicetag>-<nodeid> format.
Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iIDRAC7 1.50.50 or later.

Issue 80:

Description
The following error message is mentioned in the Firmware Update Help page:

If you navigate away from the page without committing the updates, an error message is displayed and
all the uploaded content is lost.

Resolution

The error message is not displayed. Ignore the content.

Versions/Systems Affected

All 12th generation Dell PowerEdge systems with IDRAC7 1.50.50 and later versions.

Issue 81:

Description

When the iDRAC Help files are accessed from FM120x4 server, the content for System Board Inlet
Temperature Historical Data is mentioned.

Resolution:

Ignore the word inlet as it is not applicable for FM120x4 servers.
Versions/Systems Affected

All Dell PowerEdge FX2/FX2s chassis with FM120x4.

Issue 82:

Description

The Help page for Network Devices mentions that if a port is not capable of partitioning, Not Supported
is displayed.

Resolution

If a port is not capable of partitioning, Not Capable is displayed.
Versions/Systems Affected

All Dell PowerEdge FM120x4 server with iDRAC7 1.50.50 and later.



Issue 83:

Description

Performing a racadm racresetcfg does not clear any previously set Automatic Update settings as
expected.

Resolution

To reset the settings, use a command to manually clear the settings or use the iIDRAC Web interface.
Versions/Systems Affected

All 12th generation Dell PowerEdge systems with iDRACY firmware versions 1.51.51, 1.55.55, and 1.57.57.

iDRACY7 - Limitations

e If floppy emulation is enabled when a bootable USB key is mounted as a Virtual Media from the
Virtual Console and if you try to delete any file from the mounted USB key (floppy), the blue
screen appears immediately.

e Web server session time-out is not exact. It is either 10% more or 15 seconds more, whichever is
greater.

e  WinRM and RACADM commands may become unresponsive during BIOS update or when
setting BIOS, NIC, or RAID attributes through Lifecycle Controller.

e [finvalid credentials are used for the maximum login attempts, the IP is blocked for the duration
of the IP Blocking Penalty Time and a message is not displayed.

e If Internet Explorer (IE) 64-bit browser is used to log in to iDRAC7 Web interface and when
viewing the power usage graph, the X and Y axis labels appear too small to read. This is a known
limitation for IE 64-bit only.

e The labels appear correctly in [E 32-bit browser.

e On Linux management stations, if Firefox is launched from the root user, a USB key is mapped in
Virtual Media successfully. If Firefox is launched from any user other than the root user, a USB
key is not shown for mapping because the user must have root privileges to access all the low-
level drives.

e Alert notification for battery events does not work.

e Operating system information on the System Summary page does not display after rebooting
IDRACY until the operating system is rebooted.

e {DRACTY users with user names containing a semi-colon (;) cannot log in to iDRACY through SSH.

e Inthe iDRACY7 Web interface, the power consumption sensor reading may have a rounding error
of up to 13 Watts depending on the actual power reading. This is an IPMI limitation. The power
cap, power graphs, cumulative power, and peak power are not affected by this inaccuracy.
However, the power values shown in the power graphs are average values over a period of time
and should not be used to calculate instantaneous power.

e Virtual Console uses self-signed certificates. Due to this, when launching Virtual Console from
some management stations with Windows operating systems, a certificate warning appears.

e Virtual Console in dual monitor mode is not supported and hence the behavior is undefined,
especially using Java plug-in. The primary console is used as the target console.

e The e-mail address specified in iDRAC7 Web interface -> Overview -> iDRAC Settings ->
Network -> SSL -> Generate Certificate Signing Request (CSR) page is not validated.

e On a Linux management station with Matrox drivers, from the Virtual Console Viewer if you
access the iDRAC Chat window, the mouse appears flickering inside the chat window.

e Work notes can display up to 255 characters. If any of the characters are special characters or
non-alpha numeric characters, then the total number of characters displayed is less than 255 to
accommodate overriding special characters.

e Performing a graceful shutdown from the iDRAC7 Web interface or updating the BIOS or the
firmware using the iDRAC7Y update method:



e For SLES 11 SP2:
A prompt appears for the Super user password in the operating system console. Provide the root
password and proceed with the graceful shutdown or firmware/BIOS update.

e For Windows OS in screen lock state:
Graceful shutdown does not happen because, Windows operating system has a policy setting to
disable shutdown while in locked state. Make sure that this policy is enabled.
If it is not enabled, then it proceeds with ungraceful shutdown. This is equivalent to losing
power. After the server resets, multiple options are displayed to start Windows. Select Start
Windows Normally and then check the System Event Log file. You can see that an event is
logged in for the ungraceful shutdown.

e Performing a graceful shutdown from the iDRAC7 Web interface or updating the BIOS or the
frmware using the iDRAC7Y update method:

— For SLES 11 SPe:
A prompt appears for the Super user password in the operating system console. Provide the root
password and proceed with the graceful shutdown or firmware/BIOS update.

— For Windows OS in screen lock state:
GCraceful shutdown does not happen because, Windows operating system has a policy setting to
disable shutdown while in locked state. Make sure that this policy is enabled.
If it is not enabled, then it proceeds with ungraceful shutdown. This is equivalent to losing power.
After the server resets, multiple options are displayed to start Windows. Select Start Windows
Normally and then check the System Event Log file. You can see that an event is logged in for the
ungraceful shutdown.

e Inthe iDRAC Web interface > Overview > Server > Lifecycle Log page, when the filter criteria
results in nothing found, the Log Results section does not display any user-friendly information
and it is blank instead.

e VNC disconnects after host reboot on Wyse PocketCloud,
e Encrypted VNC does not work through Real VNC client.
e VNC does not work through mobile when encryption is enabled.

e OS to iIDRAC communication through the USB NIC interface is not supported on RHEV — H
(hypervisor) system.

e OS to IDRAC pass-through feature does not work when the host operating system is Linux.

e {DRAC Virtual NIC driver is not loaded when Windows 2008 SP2 (64 bit) installation has
completed.

e When Virtual Console is in Lifecycle Controller, if Next Boot is set to BIOS Setup, rebooting the
system boots to Lifecycle Controller instead of BIOS Setup.

e If the http or https service port is set to 1 or 65535, and if you launch the iDRAC7 Web interface
using Google Chrome browser, it does not launch iDRACY. This is because of a limitation in the
Google Chrome browser. The resolution is to use Internet Explorer or Mozilla Firefox browsers.

e You cannot start the iDRAC after updating the NIC firmware, because the update process resets
NDC. To resolve this issue, reset iIDRAC after updating the NIC firmware.

e When IDRAC NIC is in shared mode and the host system is power cycled, the network
connection is lost for a few seconds. During this time, if you perform any action in the active
VNC client, the VNC session may close. You must wait for time out (value configured for the
VNC Server settings in the Services page in iDRAC Web interface) and then re-establish the VNC
connection.

e The ports 6000-6063 are reserved for x-server display. Hence, any service configured with these
ports on iDRAC is unsuccessful. Use ports other than 6000 to 6063 to configure the service.

LC2-RS - Fixes

PCle SSD configuration should be blocked through Remote Services.



LC2-RS - Important Notes

If the IDRACY version is 1.50.50, Lifecycle Controller version must to be updated to 1.3.0.x.

LC2-RS - Known Issues

Issue 1:

Description

Lifecycle Controller may not perform the required operation correctly if incompatible iDRAC firmware is
used.

Resolution

Update the Lifecycle Controller version to 1.3.0.x if the iDRACY version is 1.50.50.
Versions/Systems Affected

All LC2-RS supported Dell PowerEdge systems.

LC2-RS - Limitations

e The drivers exposed by Lifecycle Controller are present in a read-only device labeled OEMDRY,
and the device is active for 18 hours. In a Microsoft(r) Windows(r) and Linux environment, the
drivers are automatically installed and no further action is required. In Red Hat Enterprise Linux
version 4.8 only, the drivers are not automatically installed and you have to install the drivers
manually after the OS installation has been completed.

e If the boot mode is set to UEFI in BIOS (F2 setup) and if you launch System Services (FIO) and
Deploy OS, the installation may fail or you may not be able to boot to the OS after the
installation. Always make sure that the boot mode is set to BIOS in F2 setup before launching
Lifecycle Controller and deploying the OS.

e You may see a no optical device found error if you have a non-usable DVD/CD in the optical
drive. This error does not mean that there are no optical devices on the system. If you remove
the non-usable media, then this error is resolved.

e To maintain compatibility with other iDRAC configuration tools, it is recommended that only
digits (0-9), alphanumeric (a-z, A-Z) and hyphen (-) characters be used when entering a "Name”
or "Password” string. When entering a "Domain Name”, such as 'x123.com’, a period (.) character
s also permissible.

e When attempting a Platform Update through an FTP server, specifying a valid proxy server but
selecting an invalid proxy type causes Lifecycle Controller to halt for a long period (possibly over
30 minutes) before it returns to normal operation.

e [f you see this error message “Unable to find a boot device on which to install the operating
system. Verify boot disk availability.” and if you have a USB key plugged in to the system after
booting to Lifecycle Controller, remove the USB key before deploying the operating system.

e [f you are updating iDRAC firmware using a tool other than Lifecycle Controller, do not run
Lifecycle Controller during the firmware update because doing this result in unknown behavior.
After the firmware is successfully updated, you can safely use Lifecycle Controller.

e When configuring the FTP server for your repository in the platform update, you may get a
message that indicates that a network connection exists with your FTP server; however, it may
mean that the validation process needs some extra time depending on your network setting.
Click OK on the message box, and try one more time to connect to the FTP server.

e Account access can be disabled only if there is more than one user enabled on the iDRAC. To
enable users, access the iDRAC Web-based GUI. Navigate to the Users section under the
Network/Security tab and enable users as needed. Note that at least one more user needs to be
enabled to disable the account access in the Lifecycle Controller. In the iDRAC Configuration
Wizard, the DNS Domain Name may contain a maximum of 64 ASCII characters.

e When attempting a Platform Rollback, there may be a two minute delay before Rollback tasks
are displayed on the screen.



In the iDRAC Configuration Wizard, there is no a selection for auto-attached on the Virtual
Media Configuration page.

During an UEFI based SLES 10 and SLES 11 installation, make sure that no additional USB or block
storage devices are connected to the system. If there are one or more USB or block storage
devices plugged into the system, the auto loading of drivers from the embedded storage fails.
This fails because the current implementation of SLES installer reads only from one USB or block
storage device.

If an invalid SD card is attached to the system, the values shown for "Health” and “Available
Space” options are not applicable.

An “Invalid Update Package” error message is displayed, when
— the folder containing the Update Package is not accessible.
— the Update Package is not present on the USB mass storage device.
— name of the Update Package is incorrect.
Only Windows operating system can be deployed on systems with software RAID controller.

Using Platform Update, you cannot update components such as Complex Programmable Logic
Device, Backplane, and Physical Disk. However, the View Current Versions table displays these
components.

The SATA drives and their firmware version are not displayed on the View Current Versions
page of Platform Update. To view the SATA drives and their firmware information, use
OpenManage Server Administrator or OpenManage Storage Services.

The PCle SSD drives and their frmware versions are not displayed on the View Current Versions
page of Platform Update.

Collect System Inventory On Reboot (CSIOR) must to be run before enum is successful.

iDRAC7 - Installation

Prerequisites

Before you update iDRACY firmware using local RACADM or the Dell Update Package, perform the
following procedures. Otherwise, the firmware update operation may fail

1.

Install and enable the appropriate IPMI and managed node drivers.

If your system is running a Windows operating system, enable and start the Windows Management
Instrumentation (WMI) service.

If you are using iDRACY Enterprise and your system is running SUSE Linux Enterprise Server (version 10)
for Intel EM64T, start the Raw service.

Disconnect and unmount Virtual Media.

Installation Instructions

From the Windows host operating system (managed node), run the Dell Update Package for
Windows and follow the instructions on the update wizard.

From the Linux host operating system (managed node), run the Dell Update Package for Linux
from the shell prompt. Follow the instructions displayed on the console.

From the management station, remotely update the firmware using the iDRAC7 Web interface:

1. Extract the firmware image self-extracting file to the management station.

2. Open the iDRACY Web interface using a supported Web browser.

3. Login as administrator.

4. Go to Overview -> iDRAC Settings -> Update and Rollback -> Update. The Firmware Update
page is displayed.

5. Click Browse, select the .d7 firmware image file that you extracted (step 1), or the Dell Update
Package (DUP) for Windows, and click Upload.

6.  Wait for the upload to complete. After the upload is completed, the Update Details section displays
the firmware file uploaded to iIDRAC and the status.



7. Select the firmware file and click Install or Install and Reboot. If it is a DUP, Install dynamically
changes to Install and Reboot and at the same time the Install Next Reboot is activated. When
you click Install and Reboot or Install Next Reboot, the message “Updating Job Queue” is
displayed.

8.  Click OK. The Job Queue page is displayed, where you can view and manage the firmware update.
After the update is completed, iDRACY restarts automatically.

For more information, see the (DRAC User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-
cntrllr-7-v1.50.50

Upgrade

IDRACY firmware cannot be installed on platforms that support iDRAC6 and cannot be used to upgrade
iIDRACS firmware to iDRACY. For more information, see the iDRACY User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.50.50.

Uninstallation

Use the rollback feature to return to the previous installed version of iDRACY firmware.

For more information, see the (DRAC User's Guide available at
http://www.dell.com/support/Manuals/us/en/555/Product/integrated-dell-remote-access-cntrlir-7-
v1.50.50.

Lifecycle Controller 2 Remote Services - Client Tools

Use the WinRM and OpenWSMAN CLI client tools to send WS-MAN commands to Lifecycle Controller.

WinRM

WInRM is a Windows native WS-MAN client. It is recommended to use WinRM 2.0 on Windows
Management Stations. WinRM 2.0 is installed by default as a part of Windows 7 and Windows Server
2008 R2. It can also be installed as a part of the Windows Management Framework Core package on the
following systems:

e Windows Server 2008 SP1
e Windows Server 2008 SP2
e Windows Server 2003 SP2
e Windows Vista SP1

e Windows Vista SP2

e Windows XP SP3

For more information on how to install WinRM 2.0 as a part of the Windows Management Framework
Core package, see article 968929 in the Microsoft Knowledge Base at:

http://go.microsoft.com/fwlink/?Linkld=186253
Recommended WinRM Client Configuration:
e MaxBatchltems = 50
e MaxTimeoutms = 60000
e MaxEnvelopeSizekb = 150
e NetworkDelayms = 60000
Sample WinRM Command (Enumeration Operation):
winrm e cimv2/DCIM_SystemView?__cimnamespace=root/dcim -u:[idrac user]
-p:[idrac password] -r:https://[idrac ip adddress]/wsman -encoding:utf-8
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-azbasic -SkipCNcheck -SkipCAcheck -format:Pretty

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the WinRM client and WinRM commands do not work without these
options: -SkipCNcheck and —SkipCAcheck

OpenWSMAN CLI

OpenWSMAN CLI is an open source Linux WS-MAN client. OpenWSMAN CLI source code and installation
details are available at:

http://sourceforge.net/projects/openwsman/files/wsmancli

Sample OpenWSMAN CLI Command (Enumeration Operation):

wsman enumerate http://schemas.dmtf.org/wbem/wscim/1/cim-schema/2/DCIM_SystemView -h
(idrac ip adddress) -P 443 -u (idrac user) -p (idrac password) -v -j utf-8 -y basic -R -0
-m 256 -N root/dcim -c cert_name.cer -V

Note: Lifecycle Controller uses a self-signed certificate for HTTPS (SSL) communication. Self-signed
certificates are not accepted by the OpenWSMAN CLI client and WS-MAN commands do not work
without these options: -c, -v, and -V. See the OpenWSMAN CLI readme for details on these options.

Contacting Dell

Note: If you do not have an active Internet connection, you can find contact information on your
purchase invoice, packing slip, bill, or Dell product catalog.

Dell provides several online and telephone-based support and service options. Availability varies by
country and product, and some services may not be available in your area. To contact Dell for sales,
technical support, or customer service issues:

1. Visit www.dell.com/support.

2. Select your support category.

3. Verify your country or region in the Choose a Country/Region drop-down menu at the top of page.
4. Select the appropriate service or support link based on your need.

Accessing Documents From Dell Support Site

To access the documents from Dell Support site:

1. Go to dell.com/support/manuals.

2. Inthe Tell us about your Dell system section, under No, select Choose from a list of all Dell products
and click Continue.

In the Select your product type section, click Software and Security.

4. In the Choose your Dell Software section, click the required link from the following:

N

—  Client System Management
—  Enterprise System Management
—  Remote Enterprise System Management
—  Serviceability Tools
5. To view the document, click the required product version.
You can also directly access the documents using the following links:
e For Remote Enterprise Systemm Management documents — dell.com/esmmanuals
e For Enterprise System Management documents — dell.com/openmanagemanuals

e For Serviceability Tools documents — dell.com/serviceabilitytools



e For Client Systemm Management documents — dell.com/OMConnectionsClient

e For OpenManage Connections Enterprise systems management documents —
dell.com/OMConnectionsEnterpriseSystemsManagement

e For OpenManage Connections Client systems management documents —
dell.com/OMConnectionsClient
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